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Installing KNIME Analytics Platform


For step-by-step videos on how to install KNIME Analytics Platform, please take

a look at our KNIMETV YouTube channel.

1. Go to the download page on the KNIME.com website to start installing KNIME Analytics

Platform.

2. The download page shows three tabs which can be opened individually:

◦ Register for Help and Updates: here you can optionally provide some personal

information and sign up to our mailing list to receive the latest KNIME news

◦ Download KNIME: this is where you can download the software

◦ Getting Started: this tab gives you information and links about what you can do

after you have installed KNIME Analytics Platform

3. Now open the Download KNIME tab and click the installation option that fits your

operating system. KNIME Analytics Platform can be installed on Windows, Linux, or

macOS.

Notes on the different options for Windows:

◦ The Windows installer extracts the compressed installation folder, adds an icon to

your desktop, and suggests suitable memory settings.

◦ The self-extracting archive simply creates a folder containing the KNIME

installation files. You don’t need any software to manage archiving.

◦ The zip archive can be downloaded, saved, and extracted in your preferred

location on a system to which you have full access rights.
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Figure 1. KNIME Analytics Platform versions

4. Read and accept the privacy policy and terms and conditions. Then click Download.

5. Once downloaded, proceed with installing KNIME Analytics Platform:

◦ Windows: Run the downloaded installer or self-extracting archive. If you have

chosen to download the zip archive instead, unpack it to a location of your choice.

Run knime.exe to start KNIME Analytics Platform.

◦ Linux: Extract the downloaded tarball to a location of your choice. Run the knime

executable to start KNIME Analytics Platform.

◦ Mac: Double click the downloaded dmg file and wait for the verification to finish.

Then move the KNIME icon to Applications. Double click the KNIME icon in the list

of applications to launch KNIME Analytics Platform.

 Also check the KNIME Getting Started Guide and the KNIME Workbench Guide.

Configuration settings and knime.ini file

When installing KNIME Analytics Platform, configuration settings are set to their defaults,

and they can later be changed in the knime.ini file. The configuration settings, i.e. options

used by the Java Virtual Machine when KNIME Analytics Platform is launched, range from

memory settings to system properties required by some extensions.

You can find knime.ini in the installation folder of KNIME Analytics Platform.
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On MacOS: To locate knime.ini on MacOS, open Finder and navigate to your

installed Applications. Next, right click the KNIME application, select Show

Package Contents in the menu, and navigate to Contents → Eclipse.

The knime.ini file can be edited with any plaintext editor, such as Notepad (Windows),

TextEdit (MacOS) or gedit (Linux).

Allocating memory in knime.ini file

The entry -Xmx1024m in the knime.ini file specifies how much memory KNIME Analytics

Platform is allowed to use. The setting for this value will depend on how much memory is

available in your machine. KNIME recommends setting it to approximately one half of your

available memory, but you can modify the value based on your needs. For example, if your

computer has 16 GB of memory, you might set the entry to -Xmx8192m.
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Installing Extensions and Integrations

If you want to add capabilities to KNIME Analytics Platform, you can install extensions and

integrations. The available extensions range from free open source extensions and

integrations provided by KNIME to free extensions contributed by the community and

commercial extensions including novel technology nodes provided by our partners.

The KNIME extensions and integrations developed and maintained by KNIME contain deep

learning algorithms provided by Keras, high performance machine learning provided by H2O,

big data processing provided by Apache Spark, and scripting provided by Python and R, just

to mention a few.

Install extensions from:

• KNIME Hub:

◦ Search for the Extension or Integration you want to install in the search bar

◦ Click Extensions on the results page

◦ Click the extension you want to install, and from the extension page and drag and

drop the squared yellow icon, shown in Figure 2, to the workbench of KNIME

Analytics Platform. A window will open asking if you want to search and install

the extension or integration. Click Yes and follow the instructions.

Figure 2. Install the KNIME Integrated Deployment Extension from KNIME Hub

◦ Restart KNIME Analytics Platform.

• KNIME Analytics Platform:

◦ Click File on the menu bar and then Install KNIME Extensions…. The dialog shown

in Figure 3 opens.
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Figure 3. Installing Extensions and Integrations from KNIME Analytics Platform

◦ Select the extensions you want to install

◦ Click Next and follow the instructions

◦ Restart KNIME Analytics Platform.

The Install KNIME Extensions menu provides the extensions that are available via the update

sites you have enabled.


For more information, take a look at our video on How to Install Extensions in

KNIME Analytics Platform. Also see the Extensions and Integrations Guide.

To uninstall an extension, click Help, About KNIME Analytics Platform, and then Installation

Details. A dialog shown in Figure 4 opens. Now, select the extension that you want to

uninstall, and click Uninstall….
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Figure 4. Uninstalling Extensions and Integrations
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Updating KNIME Analytics Platform and
Extensions

It is good to make sure that you always use the latest version of KNIME Analytics Platform

and its extensions.

Do this by:

1. Clicking File → Update KNIME…. In the dialog that opens, select the available updates

you want to install and then click Next.

2. Proceed by following the instructions. KNIME Analytics Platform has to be restarted in

order to apply the updates.
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Update Sites

The Update Sites are where KNIME retrieves additional software in the form of extensions as

well as updates. To see or edit the available update sites, select File → Preferences →
Install/Update → Available Software Sites.

Default Update Sites

These four updates sites are provided by KNIME and are always available:

Figure 5. Available Update Sites

KNIME Analytics Platform 4.7 Update

Site: Provides all extensions and

integrations maintained by KNIME: R,

Python, H2O Machine Learning, Apache

Spark for big data, and many more.

Contains KNIME Labs Extensions, which

are extensions that are not yet part of the

set of stable KNIME extensions because

their functionality may not yet be

finalized.

KNIME Community Extensions (Trusted):

Provides trusted community extensions,

i.e. extensions created by the KNIME

community, which have been tested for

backward compatibility and compliance

with KNIME quality standards.

KNIME Partner Extensions: Provides

extensions created by KNIME partners.

Community Extensions (Experimental):

Provides additional extensions created by

the KNIME community.

KNIME Analytics Platform 4.7 Update Site and KNIME Community Extensions (Trusted) are

enabled by default.
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Adding External Update Sites

To install extensions that are not part of the above update sites, click Add to manually add

the relevant update site, inserting the Name and Location as shown in Figure 6.

Figure 6. Add Update Sites

After adding a new update site you will see it listed in the Available Software Sites. You must

now enable it by selecting it from the list.

Adding Local Update Sites

If your working environment has limited internet access or you receive an error message

“Proxy Authentication Required” when connecting to a remote update site (provided by a

URL), you can install extensions from a local zip file.

1. Download KNIME update sites as zip files at the following links:

◦ KNIME Analytics Platform Update Site

◦ KNIME Community Extensions

◦ KNIME Partner Extensions

2. Save the zip file containing the extensions to your local system

3. Select File → Preferences → Install/Update → Available Software Sites and enter the

path to the zip file by clicking Add → Archive… as shown in Figure 7.
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Figure 7. Adding Update Sites from Zip Archive


If the same extensions are provided by a URL, you will first have to disable

the update site by disabling it in the list.

4. Now click Apply and Close



If the same extensions are also provided by a remote update site, you will

first have to disable that update site by deselecting its entry in the

Available Software Sites dialog and confirming via Apply and Close.
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Working with the Nightly Builds

Once a night, a new version of KNIME Analytics Platform is created directly from our

development branch. The Nightly Build versions available here provide insight into what’s

coming up in the next regular release. However, for real work, always use a version of a

standard KNIME release. Also read the following disclaimer before proceeding:



Really, really, really important disclaimer

This is most definitely not production quality code. These nightly builds are

what we use internally to validate and test recent developments, so they are not

tested as thoroughly as standard KNIME releases. Furthermore new nodes or

functionality may change substantially (or disappear entirely) from one build to

the next. It’s even possible that workflows you edit or create with nightly builds

stop being readable by future (or past) versions…

These nightlies are a great way to get a sneak peek at what may be coming in

the next version of KNIME and provide feedback and suggestions. They are not

a particularly safe way to do real work.
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Changelog (KNIME Analytics Platform 4.7)

Detailed changelog for v4.7.x releases

KNIME Analytics Platform 4.7.0

Release date: December 6, 2022

Release notes

This version comes with major version upgrade to Eclipse 2022-06 (from 2021-03) and

Eclipse Birt 4.9.0. Also Java has been updated from 17.0.3 to 17.0.5.

Labs extension “Run R Model in Microsoft SQL Server” was removed from the update due to

little usage within the community, to be deprecated in future versions.

Legacy database nodes were deprecated since fully replaced by new DB framework. For

more details see the Migration section of the KNIME Database Extension Guide.

Quickform nodes were marked as legacy as they are replaced by the Widget and

Configuration nodes.

Changes to the core engine, especially connected to loading workflows via unofficial API

(WorkflowManager), may break custom extensions making use of this unofficial API.

New nodes

• AP-19124: Container Input (Raw HTTP) and Container Output (Raw HTTP)

• AP-1720: Row to Column Header

• AP-7745: DB Row Manipulator

• UIEXT-456: Heatmap

• UIEXT-453: Density Plot

• UIEXT-414: Box Plot

• UIEXT-379: Statistics

• UIEXT-333: Histogram

• UIEXT-332: Stacked Area Chart

• UIEXT-317: Pie Chart

KNIME Analytics Platform Installation Guide

© 2023 KNIME AG. All rights reserved. 12



Enhancements

• AP-19760: New Geospatial Data Type

• AP-19754: Allow browsing of Server/Hub repository in file handling nodes when opened

in remote workflow editor

• AP-19753: Allow knext.Column and PandasLogicalTypeExtensionType.astype to take

extension types directly, calling knext.logical internally

• AP-19681: Allow to specify KNIME version to build Python extension against

• AP-19657: Move Python Script (Labs) Out of Labs

• AP-19651: Create a Python Script node instead of Python Script (legacy) if the user

drops a .pkl file on the workflow

• AP-19636: Try to automatically detect extension types in pandas.Series to make data

frame creation convenient

• AP-19632: Update JRE/Java version to 17.0.5.1+1

• AP-19629: "Run R Model in Microsoft SQL Server" - Nodes removed from update site, to

be deprecated in the future

• AP-19614: Build bundled Python environment for arm64 Macs

• AP-19613: Build Python meta packages for arm64 Macs (automatically)

• AP-19607: Python Extension Bundling: Allow to specify feature dependency version

• AP-19601: Allow deprecation of Python nodes

• AP-19572: Add TLSv1.3 support in Send Mail node

• AP-19545: "String to Date&Time" node to have "M/d/yyyy" in list of default formats

(standard format used in Google Sheets)

• AP-19535: Workflow Summary Extractor Node: Option to check for template updates

• AP-19507: DB GroupBy and DB Pivot node dialogs available in job view and for expired

sessions

• AP-19498: JDBC parameter type GSS_PRINCIPAL_NAME_WITHOUT_REALM

• AP-19474: Column Expressions: Improve error message when multi-row functionality is

used

• AP-19429: Snowflake driver updated to version 3.13.24

• AP-19402: EnumParameter type for Python nodes

• AP-19388: New menu item: Change Component Links (bulk changing component

instances in a workflow)
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• AP-19384: Support other types besides TABLE and View in DB metadata browser

• AP-19375: Support TIMESTAMP_TZ columns using driver Snowflake JDBC driver

version 3.13.20 and newer

• AP-19371: Hub: Linked Components should use Hub-IDs by default (supports

move/rename of source templates)

• AP-19294: Update of underlying Eclipse version from 2021-03 to 2022-06 (4.24)

• AP-19287: Rename classic Python extension to Python 2 Extension

• AP-19281: Update of Eclipse to version 2022-06 (previously 2021-03)

• AP-19266: Call Workflow Service nodes promoted out of KNIME Labs

• AP-19228: Support markdown based docstrings for node descriptions of Python nodes

• AP-19209: Python Labs: Support getting pandas type from knime type

• AP-19196: Unify Local and Remote Call Workflow (Row Based) Nodes

• AP-19188: Add support for space-relative knime:// URLs

• AP-19186: Improve Python (Labs) Date and Time support

• AP-19165: Implement delete method for Python table schema

• AP-19156: Python Node Extension: Add node type OTHER

• AP-19096: Python Node: Allow returning just one column for configure

• AP-19054: KNIME Explorer: Drag and Drop files/workflows onto other workflows should

insert into containing workflow group (similar to other file browsers)

• AP-19030: Restrict console error log in Python Script (Labs) node to the meaningful

part

• AP-18923: Components: Make "Other" node type available in Component metadata

editor

• AP-18884: Add support for sending tables with pandas.categorical columns to KNIME

• AP-18833: Extend channel building scripts to allow OS-dependent YAMLs

• AP-18743: Change default file system in temporary workflow editor to current

space/mountpoint

• AP-18553: Extend binary bundling to include pip packages

• AP-18368: Custom PortObjects in Python Nodes

• AP-18343: Python Views: Allow interactive selections in Plotly plots

• AP-18341: Create Python Scripting View (Labs) node

• AP-18122: Link to "getting started guide" to Help menu
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• AP-18084: Python Script: Send messages from Python’s "logging" to dialog console

• AP-18071: Add option to Table Editor that drop downs show values from original spec

• AP-18059: Support generating a row key for arrow input data (Python Labs)

• AP-17698: String to Number node: Add configuration option that makes the node fail

when conversion fails

• AP-17626: Password Placeholder not cleared when clicking back on a workflow

• AP-17349: Extract Column Header Node: Add option to output the column names in a

single column

• AP-17178: Add support for authentication with a service principal/application secret in

Microsoft Authentication node

• AP-16694: Add support for copying/moving workflows between workflow-aware file

systems

• AP-16428: Option to flatten DB queries (SQL query optimization)

• AP-13583: Cancel component execution immediately when at least one contained node

failed

• AP-9400: Update JavaMail to 1.6

• AP-3276: Support for Natural Sort Order (e.g. "Row9" < "Row10") in Sorter, TopK nodes

and table views

• NXT-1207: Modern UI: Quick nodes adding based on workflow coach

• NXT-934: Modern UI: Add automatically port and connect nodes after port is dropped

on “+” port

• NXT-929: Modern UI: Save scroll and zoom position between workflows

• NXT-323: Modern UI: Display workflows in tabs

• NXT-319: Modern UI: Highlight connectors of a selected node

• NXT-87: Modern UI: Copy and paste nodes

• NXT-80: Modern UI: Add dynamic port to native node

• UIEXT-396: Add Option to disable animation

• UIEXT-355: Display images in ui-table

• UIEXT-329: Enable lazy loading in TableView

• UIEXT-156: Create component to add reference lines
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Bug Fixes

• AP-19477: Copying nodes in the RWE breaks the copy-paste mechanism in local

workflows

• AP-19329: Date&Time Widget only shows execution is default is set to execution date.

• AP-19796: Updating bundled Python environments fails on Windows if Python

processes are still using it

• AP-19793: Log is spammed with warning about markdown not being installed

• AP-19792: Call Workflow Service cannot be used in hub yellow bar editor

• AP-19782: Python output consumption deadlock

• AP-19771: TensorFlow 2 can’t be installed on Apple Silicon Macs

• AP-19765: NPE when controlling Callee Workflow via Path Flow Variable

• AP-19757: NullPointerException in Version Selection node when there is a broken

source uri

• AP-19750: Update jedi version in conda env yamls used by Pref Page

• AP-19749: Extension bundling script should drop architecture filter on Mac so that

extensions built for 4.6 are also installable on arm64 4.7 builds

• AP-19736: Python preferences switch to bundled when Conda is selected

• AP-19731: JSONTransformer node: patch input via column name is not working

• AP-19721: Handle missing 'markdown' package in Python Extension envs gracefully

• AP-19707: Exception on Windows when closing the Python Scripting Dialog

• AP-19701: Workflow Loader not properly handling corrupted workflow

('internal_node_subsettings' field missing) — addresses issue reported in forum

• AP-19695: WF created with columnar table backend cannot be saved in KNIME without

columnar table backend

• AP-19686: Conda propagation error message refers to KNIME Python Integration

preferences

• AP-19677: Python Script (Labs) node dialog ignores conda flow variable upon open

• AP-19650: CVE-2022-42889 - Update commons-text library to 1.10

• AP-19640: Namespace package autocompletion fails with jedi v0.17.2, upgrade to jedi

v0.18.1

• AP-19631: Windows defender logic in installer no longer works on Windows 11

• AP-19587: Occasional failures in KNIME AP when generating report ("no value present")
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• AP-19571: Send Mail node does not require TLS if STARTTLS is selected

• AP-19493: Python Script node Errors on output related user errors are too long

• AP-19488: Investigate testflow failure for new Cancel on Failure Job Manager

• AP-19416: Moving Aggregation node: HTML link is broken in node description

• AP-19411: Opening context menu on linked component might not work (timeout due to

remote API call)

• AP-19404: Component/Metanode link type change is not undoable

• AP-19365: knime.log not created in workspace with unicode characters

• AP-19356: MacOS: Icons on splash screen look distorted; need to be removed (though,

Mac only)

• AP-19305: Python (Labs) preference page has no header

• AP-19271: Component within a component still get executed, although the outer

component is in an inactive CASE Switch branch

• AP-19172: Merge Variables Node: Node description doesn’t match applied conflict

handling

• AP-19151: If extension types with conda dependencies are registered, they need to be

available in each conda env

• AP-19148: Python Node Extension: FSLocationValue is broken

• AP-19079: Linux: Welcome Page and Layout Editor do not work on GNOME 42.

• AP-19055: Unsupported characters in workflows and component names are not

prevented

• AP-18985: Metanodes destroy connections and undo history upon drag-and-drop-

replace with Native Nodes and Components

• AP-18807: Excel Writer/Reader: Slow execution time for some files with hidden

columns

• AP-18655: Sharing the same components and metanodes multiple times requires re-

selecting the workflow group

• AP-18224: Updating components fails when inner nested component is missing

• AP-18072: Python: knio.Table.from_pandas() should implement/add row keys a lá

'RowN'

• AP-18002: Failure to copy file store due to missing directory

• AP-17955: Decompress Files may uses wrong character encoding for names of

compressed files/folders

KNIME Analytics Platform Installation Guide

© 2023 KNIME AG. All rights reserved. 17



• AP-17814: Topic Extractor (Parallel LDA) node does not show iteration statistics

• AP-15928: Feature Selection Filter node: Node is not reset after changing filter settings

• AP-15709: Unconnected node in shared component update leads to cryptic error

• UIEXT-424: Double Widget: decimal separator changed between AP 4.4 to AP 4.5

• UIEXT-331: Column filter (in TableUI) does not disappear when disabled

• UIEXT-422: Fast re-execution shouldn’t result in an error

KNIME Analytics Platform 4.7.1

Release date: February 7, 2023

New nodes

• AP-19618: Space Version Creator

• AP-19549: Space Connector

• AP-18875: KNIME Hub Authenticator

Enhancements

• AP-19958: Call Workflow: Enhance node description for default execution contexts

• AP-19925: Update bundled Python version to include fixes for security vulnerabilities

• AP-19811: Allow user to select execution context in Call Workflow Nodes

• AP-19764: Document Schema creation with extension types for Python Node

Extensions

• BD-1215: (Big Data Extensions): Add support for native Databricks driver version

>=2.6.25

Bug Fixes

• AP-20018: Node settings map entry order not preserved on paste

• AP-19986: Updating components with Hub links (knime://EXAMPLES/…) no longer

working in executor on KNIME Server

• AP-19961: Columnar Table Backend blocks the Executor

• AP-19936: Microsoft Authentication node fails with NullPointerException when during
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Username/Password Authentication on a federated Azure AD Account

• AP-19907: Updating an Executor 4.6.3 -> 4.7.0 leads to broken Call Workflow

(deprecated) nodes

• AP-19896: Call Workflow (Table Based) fails with the current mountpoint option in the

Mountpoint Connector

• AP-20077: Bad corner case handling when sharing a component on a community hub

"root" (there is no root)

• AP-20058: Keep order of incoming table domain in TableEditor

• AP-20055: Cell Replacer: Option to "Copy metadata from replacement column" is

permanently disabled

• AP-19995: Python extensions miss a feature dependency on the columnar backend

• AP-19993: Arm64 Mac build (M1) is missing in '-Xmx' memory parameter in knime.ini

• AP-19982: Python ProxyExtensionTypes do not work in setitem

• AP-19953: Call Workflow Nodes: Hub execution should be supported without connector

node when the workflow is running on the Hub itself

• AP-19946: Legacy Python nodes fail with numpy 1.24

• AP-19933: Data of Reference Reader-nodes not copied over to Workflow Reader when

nested in metanode

• AP-19916: Python Table with Void Column (all values are None) not readable

• AP-19902: Resolving (KNIME) URLs not properly working in temporary workflow copies

of server snapshots

• AP-19895: Call Workflow (Table Based) relative to option changes after the workflow is

reopened

• AP-19874: No proper error message popup when checking component update fails

• AP-19864: PandasLogicalTypeExtensionType cannot be constructed from string

• AP-19803: Memory leaked when Python node is reset / filled with weird geospatial data

• AP-19800: Call Workflow Nodes: NoSuchFileException in the callee path when

executing workflows from the KNIME Explorer (KNIME Hub Exec)

• AP-19792: Call Workflow Service cannot be used in hub yellow bar editor

• AP-19791: Support for org.knime.chem.types.MolCell missing for ColumnarBackend

and Python

• AP-19751: Create Version Node does not check if the upstream space connector is

setting a version
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• AP-19724: KNIME crashes unexpectedly on macOS Ventura (Intel) while editing a

component layout view

• AP-19679: category function missing from RTD, "after" feature not documented at all

• AP-19634: File handling connector nodes do not support workflow credentials

• AP-19627: Python Extension: cannot return empty table in execute method

• AP-19615: Create Temp Dir node should not cleanup files in the workflow data area

when running on KNIME Executor

• AP-19373: Python Path: enforce using local python files instead of conda package files

• UIEXT-672: Current JS Views overlap other views in components

• UIEXT-663: Legend is not clickable

• UIEXT-615: Bar Chart (Labs) imposes ascending sorting in Horizontal orientation.

• UIEXT-596: Multiple views fail to display view with columnar backend

KNIME Analytics Platform 4.7.2

Release date: March 29, 2023

New nodes

• AP-20269: Container Input (Repository Event)

• AP-20065: Node List Extractor (extracts lists of nodes from current installation - part of

testing extension)

• AP-18888: ZIP Archive Connector

• UIEXT-818: New Sketcher Widget node

Enhancements

• AP-20033: Provide access to KNIME home, workflow area and workflow temp dirs in

Python

• AP-19850: Improve short description detection for Python based nodes

Bug Fixes

• AP-20305: Support Hub Space Paths in Call Workflow Nodes
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• AP-20304: SSL certificate of standard server installations is not recognized any more

by AP

• AP-20038: Server password prompts pile up after suspend/resume

• AP-20221: @parameter_group annotation doesn’t preserve methods of the decorated

class

• AP-20061: Table Reader node fails to work with Hub Space path flow variables

• AP-20049: Call Workflow parameter fetch jobs on server are not discarded if discard

successful jobs is false

• AP-20030: Orphaned Python processes prevent installation/update of Python

extensions

• AP-19863: Birt Reporting: "Web Viewer" option not displaying properly

• AP-19533: Semantic Web nodes do not support proxy settings

• AP-19418: SharePoint Online Connector fails when working directory is controlled via

flow variable created by the Table Row to Variable node with use default setting

enabled

• UIEXT-790: Problem with Table View with Search box when refreshing

• UIEXT-763: Checkbox/NumberInput is not disabled when overwritten by a flow variable

• BD-1235: Parquet, ORC and other Big Data nodes do not work on Apple Silicon

(aarch64)

KNIME Analytics Platform 4.7.3

Release date: May 17, 2023

Bug Fixes

• AP-20461: Column Expression might confuse output result (in case multiple

expressions are applied and one is reversing an array input)

• AP-20460: User cannot add shared components to their workflows

• AP-20450: Kerberos constrained delegation should use domain_realm settings to

determine target service realm

• AP-20395: Server client does not enforce availability of Trigger Event classes

• AP-20390: Kerberos constrained delegation should not use account ID for for

impersonation in KNIME Business Hub
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• AP-20382: SAP Reader (Theobald) must not ignore lines that start with #

• AP-20349: Service Deployment Creator Node: Deployment-exists-action Changes to

'Fail' after Saving and Reopening Workflow

• AP-20339: Python API: Filtered iterators of VirtualTableExtensionTable cause NPE if

columns are filtered

• AP-20324: Python API: Calling the constructor of a parameter group with positional

arguments doesn’t work

• AP-20322: Python API: Classes defined inside a parameter group can no longer be

resolved

• AP-20317: Python API: DoubleParameter doesn’t accept integer numbers

• AP-20223: Python API: Constructor of parameter group objects has no effect

• UIEXT-777: Initial dialog data can’t be retrieved for nodes connected to an inner

metanode output port

KNIME Analytics Platform 4.7.4

Release date: June 9, 2023

Enhancements

• AP-20538: DB framework with support for Kerberos constrained delegation for multi

host databases

• AP-20537: Kerberos constrained delegation with support for multi host services

Bug Fixes

• AP-20541: All local workflows get deleted by editing and saving a component from Hub

• AP-20509: Illegal memory access on setMissing of struct inside of list data

• AP-20475: KNIME URLs can’t resolve all paths on Business Hub

• AP-20435: Slow XGBoost Predictor

• UIEXT-794: Table view overlaps other elements in data app
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KNIME Analytics Platform 4.7.5

Release date: July 4, 2023

Enhancements

• AP-20616: Add support for SMB3 encryption to SMB Connector

• AP-20341: Add support for Google Analytics 4

KNIME Analytics Platform 4.7.6

Release date: July 27, 2023

Enhancements

• AP-20675: SMB Connector node: Update smbj library to version 0.12.1

Bug Fixes

• AP-20346: Decompress Files node: May fail on workflowset.meta files

• AP-20707: Authorization header not set correctly for nodes that use the

WrappedAuthenticator

• AP-20683: Row to Column Header node: Duplicate row id when using the columnar

backend

• AP-20680: Custom/KNIME URL file system ignores query parameters in

mountpoint/workflow/space-relative URLs

• AP-20430: Mountpoint Connector node: Hub/server executor cannot resolve file

• AP-17672: Kafka Consumer cannot handle null keys

KNIME Analytics Platform 4.7.7

Release date: August 23, 2023

Enhancements
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• BD-1239: (Big Data Extensions): Spark 3.4 support

Bug Fixes

• AP-20795: Java API (only): "Custom/KNIME URL" File System was broken by partial

backport

• AP-20754: Updating to latest 4.7 AP is not possible (due to 5.1 Download banner)

• AP-20712: KNIME Server Connector: Typo in error message for unknown host

KNIME Analytics Platform 4.7.8

Release date: December 14, 2023

Bug Fixes

• AP-20588: Sorter node does not handle missing flow variable for alphaNumStringComp

(kudos to @richards99 for reporting 1)

• AP-20799: Shared Component in not-shared Component not updated

• AP-21089: Application menu bar reads ""NewApplication"" instead of KNIME on macOS

Sonoma

• AP-21038: Snowflake DB Loader fails in KNIME Executor if local file access is disabled

KNIME Analytics Platform Installation Guide

© 2023 KNIME AG. All rights reserved. 24

https://forum.knime.com/t/sorting-on-rowid/3370


KNIME AG
Talacker 50
8001 Zurich, Switzerland
www.knime.com
info@knime.com

The KNIME® trademark and logo and OPEN FOR INNOVATION® trademark are used by KNIME AG under license

from KNIME GmbH, and are registered in the United States. KNIME® is also registered in Germany.

www.knime.com
mailto:info@knime.com

	KNIME Analytics Platform Installation Guide
	Table of Contents
	Installing KNIME Analytics Platform
	Configuration settings and knime.ini file
	Allocating memory in knime.ini file

	Installing Extensions and Integrations
	Updating KNIME Analytics Platform and Extensions
	Update Sites
	Default Update Sites
	Adding External Update Sites
	Adding Local Update Sites

	Working with the Nightly Builds
	Changelog (KNIME Analytics Platform 4.7)
	KNIME Analytics Platform 4.7.0
	KNIME Analytics Platform 4.7.1
	KNIME Analytics Platform 4.7.2
	KNIME Analytics Platform 4.7.3
	KNIME Analytics Platform 4.7.4
	KNIME Analytics Platform 4.7.5
	KNIME Analytics Platform 4.7.6
	KNIME Analytics Platform 4.7.7
	KNIME Analytics Platform 4.7.8


